
Welcome to OZ Virtual Version 1.0 Beta 3

OZ Virtual is the product of OZ's years of research and experience in the field of 3D graphics technology.

OZ Virtual lifts the user above the level of simply navigating 3D worlds, and creates a totally interactive, multi-user 
environment, which allows the person to communicate with people throughout the world, as if they were together.

Each user is ‘incarnated’ into a personally customisable avatar, which is their representative throughout their 
journeys in the 3D worlds.

OZ Virtual will turn any valid VRML file found on the World Wide Web (WWW) into a socially interactive 
location.

On launching OZ Virtual it tries to connect to an OZ Server according to your network setup.    Then it loads the 
default (startup) 3D world, The Street, stored locally on your disk.

Once you are on The Street, represented by an avatar, you will probably meet other users, also represented by 
avatars, that you can communicate with through text or audio chat.

From The Street you can navigate to other OZ worlds by double-clicking the hot-spot signs seen on The Street or 
open any other 3D world represented by a VRML file.

Note: You can also browse the web from within OZ Virtual.    Mircosoft’s Internet Explorer 3.0 or newer must be 
installed on your machine for internal HTML browsing.

Welcome to OZ Virtual! 



More Information

For more information please check our web site at http://www.oz-inc.com/ and join the OZ Virtual Mailing List. 

If you have a question that are not answered in the Help pages, or you have a problem that is not caused by hardware
incompatibilities, you have several other alternatives to choose from.

By selecting Angel from the Help menu you’ll see an artificially intelligent angel, who knows all about OZ Virtual, 
and is able to answer many questions concerning the software.

You can check the OZ Virtual FAQ list at http://www.oz-inc.com/ov/support/faq.html to see whether your 
question/problem already has been answered there.

You may also e-mail the OZ Virtual user support at virtualbeta@oz.is and we will contact you through e-mail, 
hopefully with an answer to your question or solution to your problem.

Lastly, you can send your question/problem to the OZ Virtual Mailing List. 

Then finally, if you don’t have a problem that prevents the use of OZ Virtual for online chatting, you can go to the 
OZ Worlds and simply ask the nearest person! With a little luck you might even meet an OZ staff member who 
should be able to answer the question.



Reporting Bugs

Reporting a bug to OZ Interactive is as simple as filling out the bug submittance form on our web site at 
http://www.oz-inc.com/ov/support/bug-report.html sending an e-mail message to the OZ Virtual user support at 
virtualbeta@oz.is or sending an e-mail message to the OZ Virtual Mailing List.

As we get feedback, the OZ Virtual FAQ list at http://www.oz-inc.com/ov/support/faq.html will be filled with 
questions and answers. So be sure and check often before you send us complaints, praises, questions or flames.

If you submit a bug report, please include as much information as possible - see the bug submittance form for hints 
about the information we need to make full use of your contribution.

By submitting a bug, you are helping us to create a better, more robust product! We need your help in discovering 
potential problems.



Navigation

Your movement relies on velocity and acceleration calculations giving you the feel of momentum and continuity. 
You can use the keyboard and the mouse to navigate.

Mouse Navigation

          - Left button. . . . . . . . . . . . . Accelerate
          - Right button. . . . . . . . . . . . Decelerate
          - Both buttons. . . . . . . . . . . . Stop

          - Drag right/left. . . . . . . . . . Turn right/left (Yaw)

          - Drag forward/backward. . . Lean forward/backward (Pitch)
          - Ctrl+Drag right/left. . . . . . Lean sideways (Roll)

          - Alt+Drag right/left. . . . . . . Move sideways left/right
          - Alt+Drag forward/backward Move sideways up/down

Keyboard Navigation (direction keys)

          - Up . . . . . . . . . . . . . . . . . . . Accelerate
          - Down. . . . . . . . . . . . . . . . . Decelerate
          - Space. . . . . . . . . . . . . . . . . Stop

          - Shift+Up/Down. . . . . . . . . Double terminal velocity

          - Right/Left. . . . . . . . . . . . . . Turn right/left (Yaw)

          - Ctrl+Up/Down. . . . . . . . . . Lean forward/backward (Pitch)
          - Ctrl+Right/Left . . . . . . . . . Lean sideways (Roll)

          - Alt+Right/Left. . . . . . . . . . Move sideways left/right
          - Alt+Up/Down . . . . . . . . . . Move sideways up/down

Zoom (in out-of-body mode)

          - Z . . . . . . . . . . . . . . . . . . . . Zoom in
          - X . . . . . . . . . . . . . . . . . . . . Zoom out

Navigation modes and gravity

There are two navigation modes supported, Flying and Walking.

You enter the flying mode by turning gravity off in the Navigation preference menu.    When flying you can perform 
any of the navigation movements mentioned above.

You enter the walking mode automatically when you are affected by gravity, which happens when gravity is turned 
on in the Navigation preference menu and you arrive within a certain distance of the ‘gravitated’ surface.    In 
walking mode you are ‘stuck’ to the floor/ground and you are therefore unable to perform some of the navigation 
movements mentioned above, such as go up or down.



Main Window

The OZ Virtual main window can be resized, maximized and minimized like a regular window. 

The button in the top left corner of the main window, ‘blacks out’ the background and so removes any distracting 
items. Clicking it again brings the background back.    Try it!

Note:    The size of the window greatly affects rendering performance.    You can therefore increase navigation speed 
in complex worlds by reducing the window size.



Preferences

You can set preferences in the four pull-up menus located at the top of the control area.

Navigation
          Collision detection. . . . . . . . Turn collision detection on/off    (default on)
          Automatic gravity. . . . . . . . . Turn gravity on/off    (default on)
          Reverse controls. . . . . . . . . . Not implemented yet
          Speed . . . . . . . . . . . . . . . . . . Adjust navigation speed, also adjusted in the control area
 
Audio
          Audio on. . . . . . . . . . . . . . . . Turn the audio on/off    (default on)
          Volume. . . . . . . . . . . . . . . . . Adjust the volume

Note:    DirectSound must be installed in order to hear any sound

Display
          Light. . . . . . . . . . . . . . . . . . . Adjust light intensity

Note:    Light intensity does not affect texture maps
          Smooth shading . . . . . . . . . . Smooth shading on/off    (default on)
          Display w/loading. . . . . . . . . Should a world be displayed while being loaded?    (default off)
          Double faces. . . . . . . . . . . . . Double face rendering on/off    (default off)

Multi-user
          Multi-user enabled. . . . . . . . OZ Virtual only tries to connect to an OZ Server when a world if being loaded if 

multi-user is enabled    (default on).
          Auto answer chat . . . . . . . . . Automatically answers text chat request when on    (default on)
          Nickname. . . . . . . . . . . . . . . Your nickname as seen by other users when connected to an OZ server



Control Area

On either side of the trackball, there are two small green lights.    By clicking the left one with the left mouse button 
you can turn the headlight off and on. The one to the right is a loading progression light.

The text area to the right of the trackball is used to display information and errors.

The circle to the left of the trackball is an ‘artificial horizon’ in similar vein to those in airplanes.    It is deactivated 
when you are affected by gravity.

The upper pull down menu to the left of the trackball is used to select viewpoints.

The lower pull down menu allows you to control speed with a finer granularity than the slider in the Navigation 
preference menu.



Trackball and Out-of-body mode

The gridded sphere at the bottom of your screen is called the Trackball. By dragging it with the mouse while 
pressing the left mouse button, you can look around without changing your acceleration or direction.    When you 
release the button you are back to the same view as before.

If you If you drag the trackball (just touch it a bit) while pressing the right mouse button and then release the button 
you get into the out-of-body mode.    

When in Out-of-body mode you can see your own avatar and rotate around it. You can fix the viewpoint outside of 
the avatar by dragging the trackball while pressing the right mouse button.    To get back to ‘in-body mode’ you click
on the trackball.

If you press Ctrl while dragging the trackball with the right mouse button pressed, you can rotate around the object 
directly in front of you (orbit view).

As mentioned in the Navigation section, when in out-of-body mode you can use the Z and X keys to zoom in and 
out respectively.



Avatar Motions

You can press one of the function keys to initiate a preset motion sequence for your avatar. These can be used as a 
crude form of gestures. The motions are seen by other users having their avatars close to yours, and you can see 
them yourself when in out-of-body mode.    You can view all possible motions your avatar has in the Avatar Editor.    
To trigger a motion, press one of these keys.

      Key      Motion
      ----- ------------
      F1        Walk (normal)
      F2        Fly
      F3        Wave ("Greetings earthling!")
      F4        Silly jive
      F5        The Kossak
      F6        Splitz
      F7        Ballerina
      F8        Funky Step
      F9        Punch

Note:    Some motions are not provided for all avatar types.



Facial Expressions

Facial expressions are controlled from the keyboard, using the keyboard keys 1, 2 and 3. These expressions will be 
seen by other avatars, with varying time delays, according to the distances and lines between your avatar and the 
other users avatars.



Loading Worlds

To load a 3D world scene from a local disk file, enter the File menu and select the Open File dialog or press Ctrl+O.

To load a 3D world scene identified by an Universal Resource Locator (URL), from any TCP/IP accessible server, 
e.g. on the Internet, using the HyperText Transport Protocol (HTTP), enter the File menu and select the Open 
Location dialog or press Ctrl+L.

A 3D world scene can represented by any valid VRML 1.0 or VRML 2.0 file, refered to as a scene file.    The scene 
files can be either in pure ASCII form or compressed with GNU gzip(1) or UNIX compress(1). The ASCII files have
the standard extension '.wrl' but the compressed ones either '.wrl.gz' or '.wrz'.    OZ Virtual can also handle 
compressed VRML files having the extention '.wrl'.

At the end of the menu line in the upper right corner of the main window four scene loading buttons are located.    
The first one loads the last scene file, before the current one, again.    The second one loads the next scene file, after 
the current one, again.    The third stops loading a scene file that’s being loaded.    The fourth reloads the current 
scene file again.

When connected to an OZ Server each OZ Virtual client registers a world name with the server for the 3D world 
being loaded.    If the VRML file contains a world name node specifying the name of the 3D world the world name is
used to identify the world.    This is true for most of the OZ Worlds.    If no world name node is present in the VRML 
file the URL is used to identify the world.    When a world has been loaded from a local disk its URL is 
‘file:’+drive+path+filename.

All OZ Virtual clients having the same 3D world identity registered with an OZ Server are ‘in the same world’.    
You can only see other avatars located ‘in the same world’ as you are.    For example if the node name were missing 
from the VRML file square.wrz then two OZ Virtual clients are in the same world if they both loaded it from their 
local disk as file:c:\worlds\square.wrz or if they both loaded it using HTTP from 
http://www.oz-inc.com/VRML/square/square.wrz.



Destination Manager

The Destination Manager gives you control and information related to where you have been, where you want to go, 
and where you go frequently. Destinations are stored in plain ASCII files, so you can store as many different 
destinations in as many different files as you like.

To open the Destination Manager either select Destination Manager from the Destinations menu or press Ctrl+D.

By default the destination file OZVDestin.txt is loaded from the OZ Virtual startup directory when OZ Virtual is 
started but you can create your own destination files by selecting Save As from the Destination Managers File menu.

To open a previously saved destination file select Open from the Destination Managers File menu.

You can save the file name or the URL of the current world to the current destination file by selecting Save 
destination from the Destinations menu or by pressing Ctrl+S.

You can also add a new destination to the current destination file by selecting Insert destination from the Item 
menu in the Destination Manager.    In the Name field of the dialog box that appears, type a descriptive name of the 
location.    Type the URL in the Location field and any extra information about the world in the Description field.

From the Item menu you can also create folders to group similar locations.    To add a location to a folder, simply 
drag it over the folder with the mouse.

To insert a saved file into the current destination file, select Insert from the File menu.



What is VRML?

VRML stands for Virtual Reality Modelling Language, and has become the recognised standard for leading the 
Personal Computing community into the world of Virtual Reality, which has in the past been viewed as the domain 
of expensive computers.    OZ Virtual supports both VRML 1.0 and VRML 2.0.

VRML 1.0
OZ Virtual supports the frequently used VRML 1.0 nodes.    This includes:

Geometry nodes: Cone, Cube, Cylinder, Indexedfaceset and Sphere
Property nodes: Coordinate3, Material, MaterialBinding, Normal,

NormalBinding, Texture2, Texture2Transform,
TextureCoordinate2, ShapeHints

Transform nodes: MatrixTransform, Rotation, Scale, Transform,
Translation

Group nodes: Separator, Switch, WWWAnchor, LOD
Other nodes: OrthographicCamera, PerspectiveCamera,

DirectionalLight, PointLight, SpotLight, WWWInline, 
Info

Unsupported: AsciiText, IndexedLineSet, PointSet, FontStyle

Extension to VRML 1.0
Live3D Extensions: Background images, animated textures and spin groups.
Sound Nodes: Directed sound, Triggered sound, Point sound

These sound nodes closely resemble the VRML 2.0 sound nodes. They currently support 
'.wav' and '.mp2' (MPEG-2) sound files, as well as '.oza' files which are sequencer files in a
proprietary format.

Collision detection, Gravity, and proximity sensors with translation and rotation.

VRML 2.0
OZ Virtual supports the following VRML 2.0 nodes:

Grouping Nodes: Group, Transform
Special Groups: Inline, LOD, Switch
Common Nodes: AudioClip, DirectionalLight, PointLight, Script, Shape,

Sound, SpotLight, WorldInfo
Sensors: PlaneSensor, ProximitySensor, SphereSensor, TimeSensor,

TouchSensor,VisibilitySensor
Geometry: Box, Cone, Cylinder, ElevationGrid, IndexedFaceSet, Sphere
Geometry Properties: Color, Coordinate, Normal, TextureCoordinate
Appearance: Appearance, ImageTexture, Material, TextureTransform
Interpolators: ColorInterpolator, CoordinateInterpolator,

NormalInterpolator, OrientationInterpolator,
PositionInterpolator, ScalarInterpolator

Unsupported: Anchor, Billboard, Collision,    CylinderSensor,
Extrusion, IndexedLineSet, PointSet, Text,
FontStyle, MovieTexture, PixelTexture, Background,
Fog, NavigationInfo, Viewpoint

In addition OZ Virtual has full support for local proto types.



OZ Worlds

Essentially most any VRML 1.0 or VRML 2.0 compliant scene file can represent a 3D world for OZ Virtual users.    
However a set of extremely rich worlds, specifically designed for OZ Virtual are available.

OZ Worlds URLs are as follows:

VRML 1.0
http://www.oz-inc.com/VRML/orion/orion.wrz
http:// www.oz-inc.com/VRML/ozkids/ozkids.wrz
http:// www.oz-inc.com/VRML/ozrecords/ozrecords.wrz
http:// www.oz-inc.com/VRML/spacechat/spacechat.wrz
http:// www.oz-inc.com/VRML/sputnik/sputnik.wrz
http:// www.oz-inc.com/VRML/square/square.wrz
http:// www.oz-inc.com/VRML/stage/stage.wrz
http:// www.oz-inc.com/VRML/street/street.wrz
http:// www.oz-inc.com/VRML/nightclu/nightclu.wrz
http:// www.oz-inc.com/VRML/nightcno/nightcno.wrz

VRML 2.0
http:// www.oz-inc.com/VRML/ozrecords/ozrecords2.wrz
http:// www.oz-inc.com/VRML/reversi/reversi.wrz



What is an Avatar anyway?

The word avatar originates from Hindu tradition and mythology, which states that various gods and deities took an 
interest in human affairs, and materialised among us, using a human form to represent themselves in our physical 
world.

OZ Virtual’s avatars are your representatives within the 3D worlds, and as you navigate through the varying sites 
and locations, they will appear to others exactly as you have designed them. You control the avatars every movement
and action, giving you the control you need to take advantage of the 3D worlds to the full.



Avatar Editor
You are provided with an initial Avatar.    To select another avatar you open the Avatar Editor, either from the 
Communication menu or by pressing Ctrl-A.    Each time you run OZ Virtual you will start-up using the same 
avatar you ended using the last time.

The initial property page shows your avatars as snapshots with names. You can select an avatar by clicking on it.

You can create more avatars by pushing the New button. Select an avatar type from the drop-down listbox. The 
avatar type defines the shape and appearance of the avatar. Enter a name for the new avatar in the edit field. Press 
OK to create the new avatar.

You can delete an avatar by selecting it (clicking on it) and then press the Delete key on the keyboard. 

The window on the left displays your currently selected avatar. You can zoom back and forth by clicking the left 
mouse button and dragging the mouse up and down in the window. You can rotate it by dragging the mouse to the 
left and right. You can also move the light source by clicking    the right mouse button and dragging the mouse over 
the window.

When you have selected (or created) and/or edited the avatar, press the OK button exit the Avatar editor.

With the Avatar editor you are able to customize many aspects of your avatar. 



Customizing Your Avatar

The avatar property sheet has the following pages:

Pieces

Some avatar types allow you to select different pieces for the avatar's body, different heads for example. The 
Pieces property page displays all available pieces and allows you to select the desired piece from a list. A detailed 
view of    the piece appears in the window on the right, and you can zoom, rotate and move the light the same way 
as in the left window.

Notice the button(s) at the bottom of the property page. These allow you to select a particular part of the avatar. 
For humanoid avatars, for example, there are Torso, Head and Feet buttons. If you select the Torso button, for 
example, you can choose from the variety of different torsos in the piece list.

Colors

Select a color area from the list. Change the color of the area by clicking and dragging the small spheres in the 
weird color selector in the right window, or by pushing the Color Dialog button,
to select a color directly. Remember the parts buttons on the bottom of the property page.

Scaling

Select a viewpoint with the Front, Side, Rear and Top radio buttons. Enlarge and shrink by clicking the horizontal 
and vertical + and - buttons. You can reset the scaling by pressing the middle 
button. You can also change the size by clicking and dragging the mouse over the right window. Remember the 
parts buttons on the bottom of the property page.

Motions

This page doesn't actually change anything, it's just used to preview the avatar's motions.      Select a motion from 
the list. Start and stop it with the Start button. Change the speed of the preview with the slider.



Chat Manager

The Chat Manager window is automatically opened when you connect to an OZ Server.    There you can see a list of 
other users connected to the same 3D world as you.    Also you see all chat groups and their members this world has.

You can either text chat or audio chat with other users.



Text Chatting

There are two text chat modes, Private chat and Group chat.

Private text chat

To request a private text chat with another user select the icon for the person in the Chat Manager list, press the right
mouse button and select Request private chat in the pop-up menu. Another way to request text chat is to double-
click the users icon in the list or double-click the users avatar.

When you request a private text chat the icon for the person will turn red and the other user will be notified of your 
request. Your icon will turn red in his Chat Manager window.

To accept a private text chat request and establish a chat session select the icon for the person requesting the chat 
(the red one), press the right mouse button and select Answer chat request in the right button pop-up menu.    You 
can also double-click the red user icon

To end a private text chat either close the chat window or select the icon for the person you are chatting with, press 
the right mouse button and select Close chat in the right button pop-up menu.

Group text chat 

You can either join an existing group or create a new one.

To create a new group click the right mouse button in the chat manager and select New Group.    Enter the name of 
the group, and if the name is accepted, a group chat window will open, with you as the only group member.

To join a group you select the icon for the group in the Chat Manager list using the left mouse button, press the right 
mouse button and select Join Group in the pop-up menu.

To leave a group text chat you just close the chat window.



Audio Chatting

To request an audio chat with another user select the icon for the person in the Chat Manager list, press the right 
mouse button and select Request audio chat in the pop-up menu.

When you request an audio chat the icon for the person will get a phone hook and the other user will be notified of 
your request. Your icon will get a phone hook in his Chat Manager window.

To accept an audio chat request and establish an audio session select the icon for the person requesting the chat, 
press the right mouse button and select Answer audio chat in the right button pop-up menu.

When an audio chat session has been established the icons representing your party turns green and a dialog appears.  
The dialog shows a message box from the system, a green light that blinks when your voice enters the system and a 
slider to control your partys voice volume.

To end an audio chat you either close the dialog or select the icon for the person you are chatting with, press the 
right mouse button and select Close audio chat in the right button pop-up menu.

Note:    Microsoft DirectSound version 3.0 has to be installed in order to have the full-duplex audio chat 
functionality. The DirectSound version 3.0 drivers for full-duplex are only avaliable for Windows 95.    If the person 
you are audio chatting with has an older version of DirectSound (or is running NT 4.0), you will not hear his voice, 
but a message telling you that.    He will though be able to hear your voice if you have DirectSound 3.0 installed.

Note:    The audio chat is only guaranteed to work if you have a 16-bit SoundBlaster soundcard.



Communicating with the OZ Server

You can communicate with an OZ Server through the Console window selected from the Communications menu.

The Console window is like any chat window where you can issue commands to the server.    The server can tell you
everything you need to know about the state of worlds and users, such as what users are located in the same world as
you are and also who are in other worlds

Typing help will give you a list of commands, together with explanations of what they do.



Network Setup
 

In order to use OZ Virtual as a multi-user system it needs to connect to an OZ Server and the Multi-user option must
be enabled in the Multi-user preference menu.    If OZ Virtual is not able to connect to an OZ Server it starts in a 
Single-user mode.

If your computer is behind a firewall, you must also take the following steps:

1) Select Network in the File menu. 

2) Check Use Proxy

3) Enter the IP name or number for the proxy server in the Proxy field

4) Enter the port number to use on the proxy in the Port field

5) Enter the domain name for the internal network in the 
        Bypass IP field [Optional]

IMPORTANT: For the network settings to take effect you must restart OZ Virtual.



Minimum Requirements
 

Hardware

90 MHz Pentium processor
16 MB RAM
Graphics card with 16 bit color
Sound card (optional)
- 16-bit SoundBlaster is needed for the audio chat
Networking hardware (modem or network adapter)
- required for multi-user functionality

Software

TCP/IP (Internet) connection 
- required for multi-user functionality

Microsoft Windows 95 or NT 4.0
Microsoft Active X
Microsoft DirectSound (optional, for 3D sound support)
- version 3.0 is needed for the audio chat
Microsoft Java VirtualMachine (optional)
- required for Java support (script nodes) in VRML 2.0



Tips

-    Large 3D worlds can be slow to load and slow to navigate through. 

-    One method of speeding up the loading is to turn off the display while loading option in the Display preference 
menu. This will prevent you from seeing the 3D world as it loads, but will decrease the loading time dramatically. 

-    To increase your navigation speed, avoid using the double faced polygon option. Other options affecting the 
speed are the collision detection, gravity, the smooth shading, size of main window and the sound.

-    At great speeds the minimum collision detection distance becomes rather large making it very hard to navigate 
in crowded spaces.



Troubleshooting




